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The menus are context sensitive. This means that those menu items are
available that are relevant to the work currently being carried out. If the
cursor is located in a text, then all of those menu items are available that are
needed to edit the text. If you have selected graphics in a document, then you
will see all of the menu items that can be used to edit graphics.

File

These commands apply to the current document, open a new document ,or
close the application.
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Edit
This menu contains commands for editing the contents of the current
document.
View
This menu contains commands for controlling the on-screen display of the
document.

Insert

The Insert menu contains commands for inserting new elements in your
document. This includes sections, footnotes, notes, special characters,
graphics, and objects from other applications.

Format

Contains commands for formatting the layout and the contents of your
document.

Tools

Contains spelling tools, a gallery of object art that you can addto your
document, as well as tools for configuring menus, and setting program
preferences.

Table

Shows commands to insert, edit, and delete a table inside a text document.

Window

Contains commands for manipulating and displaying document windows.

Help

The Help menu allows you to start and control the OpenOffice.org Help
system.
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II‘ Learn in English

Use the Unfiled Notes section when in doubt

When you don't have time to think about where your notes should go, just
click Window logo key + N which immediately launches OneNote and
creates a new page in the Unfiled Notes section (click the button at the
bottom of the Navigation Bar to jump to it later). It's okay if this section gets
big. You can drag the pages to other sections later, or just use search to

find them in this section.
Unfiled Notes section
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10- When you don't have time, where should your notes go?

a- All Notebook List

b- Unfiled Notes Section
c¢- Personal Notebook

d- Work Notebook
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II‘ Learn in English

Open a site from Office SharePoint Designer 2007

To open a SharePoint site, you must have at least the View permission for
that site. This permission is included by default in the Full Control, Design,
Contribute, and Read permission levels. If you don't have the necessary
permission, contact your server administrator.

As an alternative to the following procedure, if you have recently opened the
site, you can point to Recent Sites on the File menu, and then click the site

that you want to open.
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1- On the File menu, click Open Site.
The Open Site dialog box opens.
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By default, the Open Site dialog box opens with Web Sites selected on the

My Places bar and displays all sites that have been opened by using Office
SharePoint Designer 2007.

2- In the Open Site dialog box, do one of the following:

In the large list box, click the site that you want to open, and then
click Open.

In the Site name box, type the URL of the site that you want to open,
and then click Open.

For example, you might type http://My_server/My_site.

Note: No folder or site names appear in the Site name box until you either
start typing or click the arrow.

3- If there is currently another site or file open, the site opens in a new
window.
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10- To create a new website you: (Select all that apply.)
a- File>New—>Page b- File>New—> Website
c- File>Website>New d- File->Page>New
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II‘ Learn in English

Tables

Tables are the core database objects. Their purpose is to store information.
The purpose of every other database object is to interact in some manner
with one or more tables. An Access database can contain thousands of tables,
and the number of records each table can contain is limited more by the
space available on your hard disk than by anything else.

Reports

You can display the information recorded in your tables in nicely formatted,
easily accessible reports, either on your computer screen or on paper. A
report can include items of information selected from multiple tables and
queries, values calculated from information in the database, and formatting
elements such as headers, footers, titles, and headings.
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10- Which object do you use to store information on Access?
a- Table b- Query
¢- Macro d- Form

11- Which object do you use to print information on paper?
a- Table b- Query
c¢- Report d- Form
faS ol Iy Access jo Wz (Jouzr slasl ogzi 9 00,5 Gy p2i |y Jguzr - Y
Togu o0 oolawl Access jo g, 51 1> —1Y

S sy |y byl sl eolawl Judo g 00y pli 1y Access jo 39590 gLl V¥

o= 99037

-
A4S 0,3 Example4 oU L My Document o 5 slbx!| Jsa> G Access lawgs — <4l

WS 3 )lg 1y 5 Sledbl § asein Wosls glp ) g55

Seild o)lods | Jamo | Solgls el el
FEYOVY APAR Oge0 (G
ARARAIN 4 P ATy e ol
FEfov) YA &y oles

A....S oﬁ_">5 |) IR él:)u‘ J5..\? -z



@iy )5 saly

ol coly by

(@sba) Glo
los e
A v

\ O X

4S04 g o0 HUAIII 4aSI 3 ) LIS sl g (ol dadlas G us
LK b 1 Laa e s 5 ssliied b a8 S alasd Jgeal =Y
80 £y |y IR S sl J goal =Y

a8 s 5 1y dadanly 5 dadin oo olal sgas <Y

S gain g S GEOIS 59 asa 5o slasals =¥




SheSS solal sl n8ta 55 1 S ylge dilasy

VAN oIS cale s olilgs

doddo §—

Sl 5t e o3liiul Jolaz 55 o0 0,538 Sl I slaods iules sl i 5l Yaens
Ol jleads <l i law e gel> Wilgi oo b i sba il cod Sledlbsl SO ¢l
Ll SLeMbISTl ) gagaz 3,55, b 03,8 ialg |y bao,sS ) onl dualsse [ST.asl o8 15

|y 595 5155 050 lilar Lasiine 45 50l b 0ol plool oy S 5l aoliznl L 1 IS sl ailsico S
Ay s ool Lis gl Ty byl oSl 51 glaods anlyy 51 Ll ams alodl Jsaz s,
e oolizial lal35 51 il S sl 5,5 S gama i3

ol slacellad 3,0 slyr Jlo o ol 55 45 1 ol b oS 15 o Slae VL 5l L
o el b 5 G ol o bl eiss w355 ol ool b 545 o e esl
Ly opoe et sliael VL mobans ol oo solital (gl 00l plonl Jlo o1 o a5 1, slacelas 5|
Sl 4 sl Ygane Access ;5 03790 GBS S i rad 4 0 oo Blo sl
ails 53 50 Wb (5,155 s i a5 asil 0gd e soliiwl Sledlbl SGU o 34590 ledlb
3l b az g 005 SLaS 4z 0iS e agg ol gl |y (5155 o (bl oS coul il
s slaiyline s SLedlbl UL o Jlie gl aups Ligles o] 4 agly |, oledlol
S8 a5 aVle g allale (9,8 5l Slows T Sol> b 958 o0 At o e Sl (sl a5 (B1S
S o 555 3550m 40t o asli 51 5 SIS 3 o5 o 3 Al ol iy b Y garns
D95 38 (555 50 w2 S game (59,8 (lie b wilabe (35,8 (5

NS> e 0,5 dles ool alise sl o155 sl g 5l eslatwl b sl ¢ Sasly ol jo
05 3l Lo Ll jo o i8S (e 13 1) Lo 1557 )0 S92 50 Slhigioms plodez ot 5 ol
odalie 5 )35 59 35290 slaosls gy, S ()55 amaoly g axio i 3,5 ()l
b agalys Ll 5155 Ol g (3155 Glalei i

L3 51399 31 ool b v 41 35 Slows! H-Y

Sledbl a5 by o Jol Cond 0,5 i Lol Cand 90 4y g5 o 1) Access sla b )l58 Olgioee

ol Ay e g9l g Aol Aotio pu lgie Aile WS ged s (5,155 j0 aS



ol bl 5 Sia 3 eyl @laa 5 8 glosl — elaial H sl 5 S ol
ety LIS G 1 lailticel Al EI LI58la 5 el laatical als Y AY

ol5T dalllas o Lok YoYY/YE/N /¥ o ek

S5 o oslaiwl Create 4l ;I Reports 09,5 1o 59> 90 sloaeSs 3l Access ;o 5,155 ol 1y
G= 9 o b Jooz l lools 45138 Access asli s (Report aaSs (59, SIS L .(0-) JS2)
e 0SS @ Jgur ald e 5 009 (slosle pleaz ol B15 cnl oS o sl Sais g0
2,55 03,512 1y Lo 5L wosbs (3155 el J51.0,05 (o0 58 (3135 0 el b o ] oz p 65

S o olgsds S 4y g 00,5 alps 1) o)F il o

4 Lahdt |

| ] Wik Bepord L
. :iuﬂllull-'.l.'i.':l :\'tf'fll'l
Reports 6 9 ,)S 8-\ s
Sl 05 gieg)S Jgazr abd sz b G oledlbl sl plgiee |y G315 50 0920 DleMb]
Jyaw u] Gl aS s, sl law Lol e Joame ol (oilS ey e o,S G0y ,S
g o oold Hlas eads il o

Report oyl 339 3 caldicl

sl amo oo ol an a8 glagealy lusy (3,138 dod Sl Sl Wiz g L Report sl
Ol 69y 3l asalss oo 8 Ceal (052 5 on b Jsoz Sl sz 69)l5e Sl o Jlges (] 035 o0
Wosls (aiog S Holaie 4y Lol hled g 0d (8,155 50 b o5 (plaald sl el angs 415
oo Sz g oy3S )0 d52>ge polic ooz (5155 slecsls (g3l e (SSa ()15 8
Sl I35 yolie (SIS S g 55

SIS Create 4L ;| Reports o5, 5 ;5 Report Wizard as5s (59, Report o154 51 solazwl 4l
Tables/Queries (593L Cand ;0 g ;0I5 ol j0 (O-Y JS&) 043 3L Report Wizard ,ol5 b oS
J9oz 01 5 05790 slaald cesjpd I 0l b oS Ll 1) 055 55 5550 g7 5 o b Jsor
e 2] aass ool wl U g e o0l L Available Fields cuoud )0 5> g oy b
2529 oo b Jsas ol loald las 5l olg oo 22) aaSs 5l oolil b ¢ bl slaals
2,5 oalarwl 5,158



T Hiedc g i v} Ot o rirE

P £ Famnier o s W S tatie o Ty

Sl glaals
5o &l gl eads
30 39250 slaals . |
ol e 8l
ool ylis Cand

Szson b gz
o

S -

Rt altyl

Report 3,319 ()] dadn 0-Y s

G09S gl 1) L Joled o)l INEXt daSs (59, SIS 5 ,lai 050 (gloald Sl 3l
= 1y Lassls ;1 1ai 050 slaald Ol b lgs oo o ] )0 (B-F JSK8) 058 o0 Lo osls
0,5 (g3i0g,S ald iz L S5 sl

Slp S ploals
0A ul;;b‘ 05;
axao YL o

Y K

Report o, 339 j3 oals (sais0 g S O-Y JSuis



(0-F JS) aas GLasl 1y (5155 s )55 ) (53l po 090 Ailes o NEXt aaS's (59, SIS L
05k a5 (SolglEels sl ) LosysS) ol on oS 0 iy (ool (51557 50 (Jle sl
Dgige 2B IS 5 Lall By o i i 4 ey (Solglpl )5 Gl b0 S e (s0920

Vi £ 55 1 eniee by v b i P, i ey
el o destirvheg onder.
1] []

] Do

LI

—
. e
g
= P
= m—
-
— —
——
—— w—
—
——
——

w—
—_—
_—
—
e
—
—
=
—
ot

)

Report ayl 33 9 yo Laoals (5 jbeucsd o 0-F J<ui
Ol 5048 59 o 5L pb e 4 (slo,glore 5l Grouping Options ... 4eSs (59, S5 b Lo
Sla i G55 53 eJlie sl 0,5 L3I IS 1y a1 s 5l glasdls sicss
55 Lol 555 slei a1 Lo i fymme olgicsm sl i
Coomnd oyl 10 (B-0 JSi) 990 oo 00ls oyl Report o )l55 (gaw jol5 Next aaSs (59, SIS L
Oledzz Lag,rb ool )5 il (2155 ln |y Layout cand )0 39290 slag b 51 (S plyis
slad &0 an | olie Stepped b (Jle lp a5 (o0 paFie | )15 3 S92 90 polie
Sg>g0 sloa ;T 0,5 Ol | 3158 axan Cya lgi oo Orientation Ceowd )5 008 oo i ye
.. Landscape g Portrait Ceod oyl jo
S 0L m (O-F JS8) 3,5 i | (3155 S (lioe Report s lg (a0l 50
WS (oo S Ly G55 50 952 ge e ol slaig ojlul s S, €y 3



G 3 9z

a8 ol Sl
4 lals o3lul
[V"‘Ia*‘.. 5 (slS:"‘“:~

Sy )0 a5 Sgd oo

Report 3yl 339 yo Laald Gleasa o gl QAT 0-0 Jsid

Report 4yl 339 jo (i, 38 Sacu QAT O-F S

L olss oo ads o opl 50 (O-Y JSi) 05 oo yalls Report 8,154 018 oy 5T Next g4, SIS L
Iy oo ags 5,155 isles i Finish 4 oS5 (g5, SIS 4 Preview the report as 38 bl

=k sl jo 1y 5158 Modify the report's design i35 il b les oo Lo 5,5 saalie
2,5 oanlie b,l55



Report 3,319 /AT dads O-V Jsid

Report o154 51 eolatwl b o155 sl 2 JL?.»E
31 ysdaie (pay 0,5 walgs ags ) Northwind ¢S )8 0 89290 DY game 51 20,155 (e ol jo
g o oslaiwl wulos I olul L3 Waxly ;o a5 Northwind aiges SleMblSSL
48 5L |y Northwind a5ges Sledbl SGL g 00,5 1,211, Access asli -
oS LS ol b ass SIS Report Wizard asSs (g9, Reports 09,5 g Create aib; ,o -V
39 o 3L Report Wizard
S ol | Table: Products 4 35 Tables/Queries (sgi3b Cod 0 =Y
4 Available Fields cw.d ;| |, Category g Product Code Product Name slauls —¥
Available Fields cooud o 1530 slaals (gq, jekaie pay .auS a8lsl Selected Fields
WSS SUUS 2] a8 (59, ,h 050 ald Ol 51 ey b os,S SIS Ll
5 4SSy 8 0 g ool li 8 )lhg (g azis b auS SIS Next aeSs (g9, -0
<Lzl 1) Category aLs 45 54 >¢ Do you want to add any grouping levels < Le
Gasaiws Category uld slae » (5,155 15 pl b oS SUS (2] asS's (64, 9 00,5



I, Product Name 435 g 00,5 S_dS' 1 (g9-53L cand (g9, oS SAS Next gq, —F
©d9%0 b 4y 5 Ll B9 > (gl DY game o5l 4 (O-A SD) ST S
4SS 69y (95 S il o 9T, s Sl Bl oe 0B aialeS O e
JSi 4 als g 00,5 a5 Descending cdl> 4y aeSs (ISl b .asS SIS Ascending
S ales e LIS e Jy
ha sex ! oreiey 48 o war for detad recordg
Wouy e gt yup s Four ekle, in sihae g5, ST
e 'MHw- : Secte, | o ?)
& ol cdl @eSs
[ Ascending S
S (§0920)
5,5 dales

T TBE TN
[
TR

Ty

Sled! (5 jlucsi yo 0-A JSib
435 Orientation Cwwd 5 ¢ Outline a5 Layout Cwend [0 .0uS SIS Next (g5, -V
AusS SUS Next (g, g 00,5 bl |, Portrait
A8 SIS Next (g, g 00,5 ol |, Concourse 438 docSis Caad 0 —A
I, "oYgaxe )155" ©,le What title do you want for your report? e oS ;o -4
L bl 5,58 las o aalgz il 5155 leie gl ile cpl G5l b asS )l
oS 5 el 40w SIS Finish aeSs (55, o] Giales s ovolive § ()135 oSS (gl —Ve

(D=9 JS5) 95 s 00ls Lt (3135 Staled S



oo (ganaiws Category uld sl y» osls

OIS Gl iy 0-4 JSud
5 ool ol Gl ol 5l Blss oo 45 au0 aualss | Print Preview ol 4y glail; al> o ol 5o
(0-V e USS) 5,5 oolaiwl 5,155 sleaxas csalis

Ec,a[;j A %Q.ua;a 3 S rﬁ*%,
*:_-HIIII!I:-:_E- L e T e dete

Print Preview «3L ) 0-Y+ s

LU o=l L iasS SIS Print Preview asly ooz Caaw jo Print aeS's (g9, ¢ 5,155 Ol sl p
A4S SIS OK aaSs (59, (5,155 Gl sl (01 JSK8) 948 g0 ol Print o jgloxs jolS”

Sl bl

ol Ll
%:l> 09gde ul?d;‘ 3 —F I

2l gl il oo i
-

Print o glas juls 8-V Jsi




SheSS solal sl n8ta 55 1 S ylge dilasy

VAR oIS cale s olilgs

&l 0,5 solaiul asas o3lail g Cya pdass sl olg5 o0 Page Setup og,5 10 95250 sloanSs 5l
S o=l L aaS SIS Close Print Preview awS's (s, «ole Giolod o b 5l 29,5

O}.wc;n oals ul.....: u*’)‘)f g;>|).b ‘_gl.o.i 9 00l dw u*’)‘)f u..oLoauwu

51 (la=s ) 8) Employee Jouo sl 1) (20,155 Report o159 5l eslazwl b ww@
E-mail Address [First Name {Last Name glaalé ¢ 03,5 slbw| Northwind aiges SledMbl Gl
5 00,5 (gais0g,5 Job Title ol sl p 1, 5,155 .0uS adlsl T 4 1, Job Title s Home Phone
ol Sules g aupo plol gogre IS0 45 g Last Name ald wlol p 1, (5,155 (g5lecs
b slai oly aliai Gy ey L Ll )0 00505 Ola ol Jgl amivo 5l 5 00 5 ssaliia |,

NP ui")‘}f
Label ..\J|_}:ﬁ3 S euldiwl L e Al?:ﬂ

ol ;5o Jlte gl oS Oly cez o) ) AT 4 B anS e o s 6
o3 8l LS ol (sl S Ll 55 ol e oaled sl (oS SlS 35,58 e il
Lol gty S5 slat )5 (55, (st jsb a1y Loyl 5 00,5 2l o lagT Jgaz 51, b yitee
500, ol caz 59, 1y 05> 1123 5 )50 Sl b wiS o o2l 3 Lol 1) Bl ol Access

by 555 53,50 Sl IS L sl 5L (55, 1, Loy

b wliug ol a5l L8 o5 el e s sl o)lgi o0 Label o)l5:4 51 Access o
Wgd ol w59, o) Dledbl aialgs o aS Ty Lemgmm b Jea> Navigation Pane cuend
asil; ;| Reports o4, 5 5l Labels asSo (g9, 3,505 oyl =l 6l p 5l 5l e oS Sl
LO-VY ) 098 g0 00ls lis Label Wizard o jgle ,olS IS ol b .aaS SIS Create

;-8 What label size would you like? &)l 5 a5 oo ,o g Label Wizard o jgloee ,0lS ;o
Filter by manufacturer gg3b Caed j0 008 GBil ) 055 JJa5s 90 w05l ailes o 010
el 5 Canypd L5 6L Ol b 0,8 asio |y s 0aisS adgr ails )5 6l les oo
Customize ... 4e5> (59, ST L .09 0 00ls ylid ol (YL ] jo 0S8 o adgi G515 1 aS
WS Gy ya5 olgsds slal b plocns  auiles oo

asao ol ;0 (BT JST8) 95-b o o3ls L ol g (gaa axas Next aeSs> (55, SIS L

DS et 1y 55155 50 ould colaiwl Cogd K5 g 03l ciigd 45 Wiles oo



G 12 (59, (B0 Sl 01 s

b asa o ol 0 aS 0s b o ooly Jiuled 9)l50g (gum Ao Next S (59, SIS 51
(BVF JS8) wiS Qlasl wigd Ol vz 69y SblyP o0 Sy (olaald
Ay o aza o ol (0 (B-V0 JSS) 058 o ol 559 (gum aas Next aeSs (59, SIS L

sl 3,00 ald QBT ] ey aiS pasiien (olg3ds ald Sl ) |y Loz p Oy 5
DS SIS Next asSs (g, 8,59 amio o5 ssaliv



Hlﬂm-nmﬂqlﬂ'

CadiLr o i, Ty
T--u-p_ 'lur-:n.lt

Syrge slaald 28 plaals

g o

T W] e L T
_lﬂ.. h ﬁl".hdl-hwuqi- i
wal o

iy g (bl 0 010 Jsd
9 See the labels as they will look printed 4 ;5 Clseil & )90 ;o Label Wizard 31 axio ,o
Modify the label a5 Clssl .o auples 1) bews » Ol iuled jion Finish aaSs 69, SIS
R ools ¢ olis bewz @‘)Jo sl a5 Sg o0 el design

Label b)‘).ta )‘ solawl L\ e ul.‘> Y JME

O 990 ulJ)MM—A uu)é‘ 9 6AL~U| uL’> 6‘)—’ ) TR JLabel 0)‘).:5 )‘ oolazuw! L’ JL..A Q”‘ o
2,5 dalg> slw! Northwind aiges Sledbl SGL 51 Customer Jgoe



ol bl 5 Sia 3 eyl @laa 5 8 glosl — elaial H sl 5 S ol
58 ety LIS G 2 fuilieal als Gl ol38la s 5a,lS il als QY
ol aalllas :o jlach Y=YY/YE/N/¥ 0 ylad

S 5L 1) Northwind aiged  Sledlbol SSb 5 00,5 1)>11) Access 4l —)

S 5 oS SIS Northwind Traders 45> g5, Navigation Pane cood ;5 =Y
(0-VF o) 09 ol Northwind  Sledb! SSL gLl fass cabises sl o,
Northuied Traders

Hangrie T Cabbgery

w Medhwend Tisders

Dibpeet Type
Tabiei and Helsted 'Sheay
Crasted Dita
Nhaadel v Duie
Feter By Group
Cusersury & Didiers
lreverbery & Purchasng
S Irers
e
Keparn
Erripulcs dad
I e ] ]
ruisisgred Olpeets

v how j

Navigation Pane o <Lodif yialad 4ii g, yad5 O-\F JSui

(Sledbol STL ol slasl ceus i pay .0sS SIS Object Type 4035 (59, o o =Y
g gn gaiaiwd (Jgile 9 9,5 IS p b 9z9imn (J992) b 8 B 0

o=l 5o aus SIS Customer Jga> (59, Tables o3 ;o g Navigation Pane ,o ¥
D8 o0 (5,55 Northwind &S i )b ie Sledlol Jgax

S el b oS SIS Labels (g5, Reports 05,5 ;0 (s g 00,5 SIS Create 4l 5, —O
g oo yall Label Wizard o glxs ;oS

4S8 ol |, HP a 58 Filter by Manufacturer coond )5 —#

bl Jol 433 o )ls 59>9 What label size would you like? &jle 5 a5 g 0 =V
DS SIS Next (g9, 9 00,5

A oS (69, ST L g 00,5 Sl | olesds cisd blad &g 10 «igd ptd om0 —A
DS S Next aaS's (g9, dslol [0 00038 5 ke sl |y 2lezds S, Text Color



als plcudy cpy asS SIS Lls Last Name olé (4, <Available fields cod ;o -4
g o b Prototype label coand jo

Iy adlold oS g 00, 5 SIS {Last Name} s Le slpsl jo Prototype label ceond ,o -3+
A28 SIS First Name olL3 (g9, Available fields coand ;o 25T .0y Loy

. ,Lisy |y Enter oIS Prototype label o3 ;o First Name ald o adlsl 51wy =YY
Caomd 4z |y o] Company a L3 g9, SIS Jols L Available fields cood ,o 95T
o ,lady | Enter oS Lol jo .ausS 43Ls! Prototype label

a5 a8lsl Prototype label cwowd 4 1) State/Province ¢ City slaalé s ped 4=V
O-VY )

Wil e o e o your e kb

Cmrminuacy your bl on e eght by choosng Sl from e 5, Yo may s
Erpe e Shat vou sould e is ses o every label nght ando. S profotps.

Frintstygs Lt
e

[Company}
o peeeRegws

G o slaalsd QAT OV Jsud

LS Wl oy ol 5o 0gd sols Las 5l g (o oy B awsS LS Next asSs (g5,—-1Y
Comnd (0 jadate (pas aaS el WS o adon |) Loz p Gl o oS
S5 Next aaSs (59, (e 9 00,5 SIS ils Last Name alé g9, Available fields

A4S SIS Finish aaSs (69, Lo p ol Gulad i s ol -1F



ol bl 5 Sia 3 eyl @laa 5 8 glosl — elaial H sl 5 S ol
ety LIS G 1 lailticel Al G LI58la 5 el i pluaticl s Y QF

ol5T dalllas o Lok YoYY/YE/N /¥ o ek

o S obwl Northwind &S 1 lase IS o0l g el ol Gl |y ez ww@
2S5 oolaiwl Employee  Jguz 5l elais

log 5ks 2B Ll S sboul ey a0 1) o 45,155 )lg5 oo Label L Report o159 51 eslawl b ax )5
sloul (Lacaigd S5, g o3l s aile) 5158 Seew b baald a0 1) Sl U oS o
L i)58 ol plis oS oolaiwl (5,155 G sl (gl Design glos 5l ol b ol jo aaS
cla &5 o IS8 ax 4 Ols sl Gledlbl a5 aps aseis aulys oo Report glos 5l oslazul
A sl 1) olgzds 3158 aled oo cawlin Ol pess plosil b a5 oy digd oo a8 S

odmlics Iy o isn pl pb =) Joaz 10 0,5 i ol i iy a4 olg oo |y 5155 azio o
oo eols ylis asras (59, (5,F S alize glaciend VA S 0 0uS oo

Oil38 S Calids slahas 8- Jgan

Slxp g ik ol
el L SO Lps g ad 5,18 515 slal o a8 conl Sledlbl Jols
) . Report Header
Pl s S L 5 415 15 5T sl o o el S ol
) Report Footer
AT

Sl G )3 g 0ad C8bys g2g e n b Jeux 5l 45 Sl (plwesls Jols
' ’ . Detail

AT
Ded so Dl o)55 amas o gl jo A conl Sledlbl el Page Header

Bed so Sl )15 s o Ll jo s conl Sledbl el Page Footer
S8 5k 0,50 Sledbl g ools ioled (gl o sl S s slacend jo ol s,
oo sla S pols )8 L wigd oo sals (A5 (65, &5 s (oLl Lo ST 05 5 (o0
ol3S 5o ool gl alite sloJ uS Access (o .S a1y 095 Hlais e (0,155 0y oo
5o oolaul J_slﬁ 6LDJ)_..S u_v).s\)).')lj).w )‘ )90 99y J)...S 9 e J)....S ] 00 4)‘)‘
g s o3laiwl (5,155 (g9, ol sie yolo 1,8 (gl (Label) cuwz sS85l anies b 1S




oolil 5> 5 o b Joa sloakd 1o Sese sboosls slyime iales slp Ygano oo JyuS )
(O-VA JS5) 9 oo

a5

ﬂ:ﬂ:------------l
O3S Elide slaciacd O-\A Jsdb

S5 5,50 5,155 (g9, Navigation Pane Ceowd )0 ¢ (3,155 6 45 by 1o Design glos cowlive 5l
8 2l cdl o )55 LS el b oS Gl | Design View 458 5 00,5 canl, SIS
Page Setup 5 Arrange Design 4l 4w Joli a5 Report Design Tools csg0 4ilij g 48,5
Ay oes 1 lai 0,50 sla 08 aulgr oo aasl cpl 5l oolatnl L .(0-V4 JSK8) 2gad o yolls
Ot 5 ool g 00,5 (suneg,S olemds glaald b ald sl o |y (5155 w0 5 aslsl i 1S
RWC NN

_i-"'i "g;ﬂj:! E-

Emsnde 28

Report Design Tools ¢ g5 g0 4L 8-V JSii

sIFont 09,5 15 85290 sdaSs 3l iz b (e sla ]S Cigd cll> g ojlil cgg s sl p
g o o3laiwl Design asly;

YR |

2,5 aalem FMol g 00,5 sl DY game 5155 U L Jol Jlo jo aST1) L5155 L ol jo
25 5L 1 Northwind 6gei SleMbl SSL -

a5 g 00,5 Cuwly SIS oy 00,5 sl MV same 55" leie b aS 55 s, Y
WS ol | Design View



ol bl 5 Sia 3 eyl @laa 5 8 glosl — elaial H sl 5 S ol
ety LIS G 1 lailticel Al oM 138055 5a,lS 10 aslieul als

ol5T dalllas o Lok YoYY/YE/N /¥ o ek

ol o g3 e b oS SUUS Bl a0 558 (59, Report Header cuud )0
D9

" oVga e Oylae 5ST 050 Sb rie o p Slgizme b oy ,Liay 1) Delete oS
Selgsds an 1) 55, 5 00,5 SIS Font Color 4aSs (59, Design «b; 5l Font 05,5 1o
A ol K, b

Ded plawg cans e B oS SIS Center 4sSs (59, Font 0,5 1o

o1y gl Silis 9 00,5 S Label auSs (59, Controls 09,5 ,o ¢ Design a4l ,o
olas as bas e U5,15" &ole L5l 5l b -0iSs Report Header 5 olgsds ton
..\....5 wl; |) "°)'.‘."\"°

ool O & hos B owes 8 ez J S LS (sleo i (s, 1y gle ,SSLES
Report cod cwly Coow @ |y 558 ¢ ugle o Cas 0S8l oSS L (935 000
S e Header

DS Ol ) VE e g 00,5 SIS Font 64,5, Font Size (s¢5L cncd (59,

kY4

-y

-¥

-4

SSL sl (Le s ylew) Orders Jgao slocws (25,155 Report o)l 59 5l oolaznl b d}“@
QS ol 1y 5,155 slaald 5l Lam elasds a4y o] 5l s g 00,5 slow| Northwind ages  SleMbl

Aol g Ao g (39 3 o i g bl O—F

i olacw.d Report Header & Footer L i )l38 asaoly g dorio pu il 4285 a5 5 las

S5 890 Sla 5 5ol )53 5 il b Gimen Nshion lr BT sl 5 bl o S, o
Sl 0155 aman o sleasl gl o 1) oJlas g5 o Page Footer 4 Page Header oo o

o,5

500,5 Canly SIS 5155 51 siend o b gled o (5158 4 axmasly g dotis pw 99531 (6l
[Page Header/Footer 4 ;5 olzlb .(0-Y - o) osS bl |y Report Header/Footer as 38

g oo a8LS] 45135 4y Page Footer 4 Page Header (slacend



Budd Beemk
(2 Sarfing and Grouping
= Tap o
B Pasie
ﬂ- Fife'liack Colar 3
B Ao FvBes Col | »
[ e
i gna
® Toclboy
UL Page HesdenFooter
W Report peaserTnater
& Bopwte

O-Y+ Jsi

2 S5icn S5 IS ats &) 5 GBI Olsie 97 SNl (155 4o p Cuond 53 Ygans
12 S5rge el 4ol o Slaald L (5 saiS e o gz SNl i il amioly
395 U515 slals s Yy axe Page Header caancd 105,85 oo 3 cims oo lis | 3155

D9l 0 7,0 )l axas o Ll Page Footer Cood

OIS pa by 9 b g
Design 4ili; 5l Controls o5,5 ;5 Date & Time 4aSs (55, (,155 4 oyloj g g, (30,5 adlsl Iy
au3¥ ol L (0-Y) JSb) 0g-i oo ol Date and Time o gl jolS )15 -l b oS SIS

Dgd eo dud 5138 8 ()18 ol> e dnclude Time sy 35 Gl b ¢ & )b Include Date

ol ol Ll

oles oS asll

olej g Ll

Date and Timeo  glas juls 0-Y) Jsu



ol bl 5 Sia 3 eyl @laa 5 8 glosl — elaial H sl 5 S ol
58 ety LIS G 2 fuilieal als Gl SlEla s 5a,lS ylailical als Y QA

ol5T dalllas o Lok FoYY/YE/N/F o yladh

G g dadis o jladdi £ ya
asb; 1 Controls 69,5 ;5 Insert Page Number 4_oSs (59, 3,135 ;0 axao o,leds )0 sl)m
o=l )9 05l e ol (O-YY i) Page Numbers o5l oS IS oyl b oS SCIS Design

S een |y 1 6005518 oo g amivo 0 )leds (0B gg5 alyi oo 0yglome 08

FE H.lrﬂhﬂ': -3' #H

Foeragh

i s i3l & Page i
s 1 eF Loy ]

o

P Bafer

W Tog of Page [riier] L axasooled 5,08 e
HBobiom of Pege [Foodes |

dxao O)LQ.:J LS"X'“)‘)" — - St
e O o . 0. .
e i -Wo)M&WﬁML{&W
o Ghovw Mumber o Frst Page ———

ol Jgl amans jo

Page Numbers o glas juls 0-YY Jsi

iges Fledbl STL Jglas 51 S5 olg2ds any Report o)l 5 5l solaiol L &)—“@
Iy =4 s o, g Report Header coond 45 1) 1)loj 9 2w ,b sl 5iS g 00,5 olowl |, Northwind

S adlsl Page Footer Cood 4

vyl 35 99 ol guiseg 5 -0

L oJLte sl S (st 5 1, Lol lnools sy o 5 ol sl s agalys s pals
e e 5l BBTL (olyas aly o o] cigSin ome s lis 2 Ol e o (500095
CYga e 9,8 a8 ddn eSS AP oo e il 1 sl 4 bgyye 9,655 (5 e CigSus
el 009y s (64 4>y Lads

ald slaw ply 5158 10 09290 slrosls wiles o Group & Sort aeS's (g9, SIS L Access o
4, Group, Sort, and Total pb L  ciewd aeSs (p) (59, SIS L 0uS (guiuog )5 olgds glaald |
Add a group 4eSs 59, SIS L cand (] 50 (O-TY SE) 048 o0 adlal b sles slel
O 5lioe 5 wd 53 51 3,50 b LI L oS 055 o 0018 (L5 B I5T (sloals S
D aleS gaiseg S alid



SheSS solal sl n8ta 55 1 S ylge dilasy

144

+ il i g sl il ot

Group, Sort, and Total Csawud O-YV JSui

oIS cale s olilgs

G35 > ALl (gaises 5 F Jlko ;5

(el Jgaz) Orders Jsa> (59, 5l (25,155 Report o154 51 eolaiwl b laml ¢ Jles cpl yo

(0—,l5) Employee o L3 sl 1y (3,155 v 5 09,5 sb! Northwind aiges  Sledol Sl

4z ae)lS e S al sl axgte (Sl S G b G 05 auleS (saineg S
Sl 0o S b o 1y ola g lew

25 5L 1, Northwind ages  Sledbl S

Jgaz )lig Jol ama o o .0 a8 SCJUS Report Wizard 4 oS (g4, Create 4l o
¢ ,5) Order Date 4 Customer ID (Employee ID slaa L3 g 00,5 oLzl 1) Orders
2SS Next aeS's (g5, 55 cpl 5l G oS a8lal 5158 a1y (ol <8l o

Employee ID o3 slie 1o 1) (2)135 )15 095 55l a0l o (2)]55 pgo axdo o
DS SIS Next aeSs (g, -l 00,5 (g0s004,5

b b sled jo 1y ()55 Ll 1o g 00,5 eudais olgsdo 4y 1) 0155 slaamans Ko

WS SIS Group & Sort 45> (59, Design ail; o

LSS ST Add a group 4.Ss (g9, Group, Sort and Total Ceend o

Access LS ol L .auS SIS Employee ID alé (g5, w0als ol sboald cand (o
WS e (§09,S ouls Ll ald sl p Iy 3158

cle plai i b oS ol |y Report View glos Views og,5 5 Create aily; ;o
Bgds oaly ylas g )15S

Qg 7, Access daliy 5l g a1 Gl oled i sles

-
Y

-y

¥

-4



ol bl 5 Sia 3 eyl @laa 5 8 glosl — elaial H sl 5 S ol
58 ety LIS G 2 fuilieal als S S13la 55 5,8t uiliead als Yoo

ol5T dalllas o Lok YoYY/YE/N /¥ o ek

oS5 jloolaiwl Ly g 00,5 oslsul Orders Jouz sl j0 (6,500 3,155 u’)—“@
WS gaiseg,S Order Date old sl 5 |y oledsl Sort & Group

II‘ Learn in English

e A table is just one of the types of objects that you can work with in
Access. Other object types include queries, forms, reports, pages,
macros, and modules

e Tables are the core database objects. Their purpose is to store
information in Database.

e You can display the information recorded in your tables in nicely
formatted, easily accessible reports, either on your computer screen
or on paper.

e You can use the Report wizard to get a quick start on a report, but
you will frequently want to modify the resultant report; you can do
this in Design View
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8- Which object is used to display the information recorded in tables on screen
or paper?
a- query b- report c- table d- form
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II‘ Learn in English

Create a basic diagram
1- Start Microsoft Office Visio.

When Visio starts, several windows appear. For now, all you need to
work with is the window titled Template Categories.

2- In the Template Categories window, in the list of categories, click the
General category. All the templates in the General category appear in
the central window.

3- Double-click the template titled Basic Diagram.
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Connection points

A connection point is a special point on a shape that you can “glue”
connectors and other shapes to. It looks like a blue x ( ). When you glue a
connector or shape to a connection point, they stay connected, even if one of
the shapes is moved. Use connection points when you want connectors or
shapes to stay connected to specific points on a shape. If the shape you want
to glue a connector or shape doesn’t have a connection point where you want
it, you can add one.
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Attach devices

To attach devices to the Ring Network or Ethernet shape by using the
shape's built-in connectors:

1- Click the Ring Network or Ethernet shape.

2- Place the pointer over a control handle <. When the pointer changes
to a four-headed arrow, drag it to a connection point = on one of the
device shapes.

When the device shape is correctly connected to the Ring Network or
Ethernet shape, the connection point turns red, indicating that it is glued.
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Set a primary key

Relationships use primary and foreign keys to map rows in one table to
corresponding rows in another table. At least one of the tables in the
relationship must have a primary key in order to establish a relationship.

1- Double-click the table in your diagram.

2- In the Database Properties window, under Categories, click
Columns.

3- Select the PK box for the column for which you want to use a
primary key.
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Use Case Diagram

A use case diagramis a diagram that shows the external actors who will
interact with your system and how they will use it. The diagram consists of a
system boundary, actors, use cases, and use case relationships.
(communicates, uses, and extends) In a use case diagram, the communicates

relationship "= defines how an actor participates in a use case.
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